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Temat 1:  

Część 1.1:  Orientacja stereogramu cyfrowych zdjęć lotniczych 

z wykorzystaniem systemu DEPHOS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. PRZYGOTOWANIE DANYCH 

a) sprawdzić, czy w katalogu D:\Tify\OrientacjaDEPHOS_2014\ znajdują się pliki obrazowe 

conv10_33.tif oraz conv10_34.tif. Jeśli nie, należy je przekopiować z serwera 

klon\pracownicy\awrobel\3_GiK\OrientacjaDEPHOS_2014\. Obrazów nigdzie nie kopiować 

z katalogu OrientacjaDEPHOS_2014, tylko sprawdzić, czy są. 

b) założyć własną strukturę katalogów w 

D:\Stud\GiK\TiF2\Nazwisko_prowadzącego\Nazwisko_studenta\temat_1\; 

 

Projekt lotu fotogrametrycznego 

(wykonany w V sem.) 

Lot fotogrametryczny  

Założenie projektu fotogrametrycznego 

Orientacja wewnętrzna zdjęć 

Aerotriangulacja bloku zdjęć 

- planowo na specjalności 

przedmiot CFLiS I mag. GIFT 
Orientacja bezwzględna modelu 

Orientacja wzajemna  

Pomiar NMT 

Generowanie ortoobrazu 

Pomiar mapy 3D 

Dane fotogrametryczne gotowe do generowania produktów kartograficznych 

Część 1.1 

Część 1.2 

Część 1.3 
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c) do katalogu \temat_1\ przekopiować zawartość katalogu D:\Tify\ projekt-Dephos-14:  

• 7 plików projektu fotogrametrycznego o nazwie:  

− tif2.fcm 

− tif2.fct 

− tif2.fmc 

− tif2.fmd 

− tif2.fmt 

− tif2.fpr 

− tif2.fpt 

• plik 50mOK.det 

• plik sidebar_AGH_Mapa.txt 

• plik sidebar_AGH_NMT.txt  

• plik triang_AGH.txt 

Uwaga: nie kopiujemy plików obrazowych TIF!!! 

 

2. Orientacja stereogramu zdjęć lotniczych na stacji fotogrametrycznej DEPHOS 

Cyfrową stacją fotogrametryczną nazywamy zestaw programów komputerowych do opracowania zdjęć 

lotniczych lub naziemnych. W ogólności programy te służą do pracy na zdjęciach zgrupowanych 

najczęściej w bloki zdjęć, składające się z szeregów, a te - ze stereogramów. W szczególności dla naszego 

ćwiczenia wybrano pojedynczy stereogram. W programie służącym do obserwacji stereoskopowej (w 

naszym przypadku DEPHOS Mapper Stereo) realizowana jest bezpośrednio zależność pomiędzy 

położeniami (współrzędnymi xl,yl i xp,yp) kursorów (znaczków pomiarowych) na obu zdjęciach a 

współrzędnymi terenowymi wyznaczonymi przez przecięcie dwóch promieni rzutujących zdefiniowanych 

środkami rzutów i położeniem kursorów na zdjęciach. Mówiąc inaczej, każdemu położeniu kursorów na 

obu zdjęciach odpowiada jeden punkt przecięcia w przestrzeni przedmiotowej (punkt terenowy). Jeżeli 

kursory zostaną umieszczone na obrazie tego samego punktu na obu zdjęciach (punkty homologiczne), 

to w przecięciu promieni rzutujących uzyskamy współrzędne terenowe (XYZ) punktu. Praca na stacji 

fotogrametrycznej polega, zatem na znajdowaniu na obu zdjęciach punktów homologicznych i po 

umieszczeniu na nich znaczków pomiarowych dokonaniu rejestracji wyznaczonych współrzędnych 

terenowych. Zasada ta realizowana jest w praktyce z wykorzystaniem sztucznego efektu 

stereoskopowego i niejako od tyłu. Zgodnie z zasadą sztucznego efektu stereoskopowego przestrzenny 

znaczek pomiarowy (dwa znaczki pomiarowe kojarzone w naszym umyśle w jeden punkt przestrzenny) 

dotyka powierzchni modelu stereoskopowego tylko wtedy, gdy oba znaczki materializują na zdjęciach 

ten sam punkt. Zatem jeśli obserwowany znaczek przestrzenny znajduje się poza powierzchnią modelu 

(nad lub pod), wtedy wyznaczany w przecięciu promieni punkt nie należy do zbioru punktów 

terenowych, a kursory nie mogą pokazywać tego samego punktu na obu zdjęciach.   

Zasadę pracy stacji fotogrametrycznej można wyjaśnić poprzez analizę równań kolinearności wiążących 

układy tłowe zdjęcia lewego (xl, yl) i prawego (xp,yp) z przestrzennym układem terenowym (X, Y, Z): 
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Jeśli znamy elementy orientacji zewnętrznej i wewnętrznej zdjęć (ck, X0, Y0, Z0, oraz kąty ϕ, ω, κ zawarte w 

elementach macierzy obrotów aii) to znając współrzędne terenowe punktu (X,Y,Z) możemy wyliczyć jego 

położenie na zdjęciu lewym i prawym. Praktycznie realizowane jest to w ten sposób, że za pomocą 

manipulatora (myszy) generowane są przyrosty współrzędnych terenowych ΔX, ΔY, ΔZ , a program 

oblicza dla prawego i lewego zdjęcia położenie (x,y) kursorów na tych zdjęciach. Równocześnie 

obserwator śledzi efekt w postaci położenia przestrzennego kursora na stereogramie stwierdzając, czy 

jest on pod czy nad modelem. W zależności od tego dalej zmienia współrzędne terenowe trzema 

generatorami myszy zbliżając się coraz bardziej do celu, czyli osadzenia kursora na powierzchni modelu. 

Po zrealizowaniu tego zadania następuje rejestracja współrzędnych, będących szukanymi współrzędnymi 

terenowymi punktu.   

Jak widać z tych równań, praca w trybie autogrametrycznym jest możliwa pod warunkiem wyznaczenia 

elementów orientacji zewnętrznej każdego zdjęcia stereogramu (elementy orientacji wewnętrznej są 

znane). Wyznaczenie wartości tych elementów jest celem procedury zwanej orientacją lub strojeniem  

stereogramu.  

Orientacja  stereogramu  w systemie DEPHOS przebiega w 4 etapach: 

1. założenie projektu fotogrametrycznego 

2. orientacja wewnętrzna 

3. orientacja wzajemna  

4. orientacja bezwzględna 

 

Ad.1. Projekt fotogrametryczny  

Jest to plik lub zestaw plików zawierających dane i metadane fotogrametryczne. W naszym przypadku 

projekt fotogrametryczny założono dla jednego stereogramu. W praktyce stosuję się zasadę: jeden 

projekt - jeden blok. W różnych systemach fotogrametrycznych projekt jest reprezentowany przez różne 

formaty plików. Na ogół są to pliki tekstowe (lub jeden plik tekstowy). Przykładowo w systemie INPHO 

jest to plik *.prj, w systemie Z/I (Zeiss Imaging) - katalog z zestawem plików bez rozszerzeń (np. camera, 

photo, model itd.). W systemie Dephos jest to zestaw plików o wspólnej nazwie – ale z różnymi 

rozszerzeniami. Każdy z plików zawiera informację na temat konkretnej części informacji koniecznej do 

jednoznacznego zdefiniowania danego bloku. Te dane to: ogólne dane o projekcie, dane kamer/kamery, 
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dane zdjęć, dane modeli, dane fotopunktów, dane pomiarów wykonanych na zdjęciach (punktów 

wiążących oraz fotopunktów). 

 

Ad. 2. Orientacja wewnętrzna  

Orientacja wewnętrzna jest procedurą, w której wykonywana jest transformacja płaska układu obrazu 

cyfrowego (pikselowego) do układu tłowego zdjęcia. Przebiega ona w różny sposób  w zależności od 

tego, czy wykonujemy ją dla zeskanowanych zdjęć z kamer analogowych, czy też dla zdjęć z kamer 

cyfrowych. 

 

• Orientacja wewnętrzna dla zdjęć z kamer analogowych 

 

Punktami dostosowania na zeskanowanych obrazach zdjęć lotniczych są znaczki tłowe, których 

współrzędne w układzie tłowym zdjęcia znamy z metryki kalibracji kamery lotniczej.  

W systemie DEPHOS do tego celu służy program DEPHOS Interior Orientation. W projekcie 

fotogrametrycznym, w danych kamery (plik FCM), są podane współrzędne znaczków tłowych w układzie 

łącznic znaczków tłowych pochodzące z raportu kalibracji kamery. Współrzędne pikselowe tych znaczków 

są mierzone przez operatora i obliczana jest orientacja wewnętrzna unikalna dla każdego zdjęcia 

analogowego, skanowanego. Przyjmuje się, że średni błąd nie powinien przekraczać 0.5 piksela. 

• Orientacja wewnętrzna dla zdjęć z kamer cyfrowych 
 

Na zdjęciach z kamer cyfrowych układ tłowy jest zawsze równoległy do układu obrazu cyfrowego 

(pikselowego). Układy te różnią się jedynie położeniem punktów początkowych i jednostkami. Dla układu 

obrazu jest to lewy górny narożnik obrazu (xp=0, yp=0), a dla układu tłowego punkt główny (x0, y0), który 

najczęściej znajduje się w środku obrazu cyfrowego albo w jego pobliżu (x0=xp, y0=yp). Różnicę jednostek 

obu układów determinuje wielkość piksela matrycy kamery (Pixel Size), która  musi być  znana. 

Współrzędne w układzie pikselowym to wielkości niemianowane, określające numer wiersza i kolumny 

mierzonego piksela. W skali obrazu 1:1 zawsze są wartościami całkowitymi. Przy powiększeniu obrazu 

mogą przyjmować wartości rzeczywiste wynikające z interpolacji współrzędnych. Przeliczenie jednostek z 

układu pikselowego na układ tłowy wymaga przemnożenia współrzędnych pikselowych przez wielkość 

rzeczywistą piksela matrycy obrazu. Ponieważ transformacja układu pikselowego do układu tłowego w 

tym przypadku sprowadza się do przesunięcia (translacji) i zmiany jednostek układu pikselowego, dlatego 

w większości stacji fotogrametrycznych wystarczy podać wielkość matrycy obrazu, współrzędne 

pikselowe punktu głównego oraz rozmiar piksela matrycy, aby program sam wykonał orientację 

wewnętrzną. W systemie DEPHOS operację tę wykonuje się w programie do zarządzania danymi - 

DEPHOS Manager. 
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Ad. 3.  Orientacja wzajemna  

Celem tego etapu orientacji stereogramu jest wyznaczenie parametrów opisujących wzajemne położenie 

i orientację kątową zdjęć. Orientacja wzajemna jest procedurą analityczną, w wyniku której 

doprowadzane są do przecięcia wybrane promienie homologiczne wiązek obu zdjęć stereogramu. 

Geometrycznie, doprowadzenie do przecięcia promieni jednoimiennych obu wiązek można wykonać  

wykorzystując dziewięć stopni swobody obu zdjęć. Należą do nich: po trzy kąty skręcenia (omega, fi, 

kappa) dla każdej wiązki oraz różnice ΔX, ΔY i  ΔZ pomiędzy współrzędnymi środków rzutów obu wiązek 

(nazywanych składowymi bazy Bx, BY i BZ). Długość bazy nie ma wpływu na przecinanie promieni 

jednoimiennych, a jedynie na skalę modelu, który powstanie jako miejsce geometryczne punktów 

przecięcia. Próba wyznaczenia w procesie orientacji wzajemnej jednocześnie trzech składowych bazy (Bx, 

BY i BZ) spowoduje, że zadanie będzie praktycznie nierozwiązywalne gdyż będzie posiadać nieskończoną 

liczbę rozwiązań. Należy, zatem ustalić jedną z tych trzech składowych, aby z nieskończonej liczby 

rozwiązań wybrać jedno. Ustala się wartość składowej bazy BX ponieważ jest ona najbardziej zbliżona do 

długości bazy B. Praktycznie w orientacji wzajemnej nie ma większego znaczenia jaką wartość 

przyjmiemy.  Wartość ta w systemie Dephos jest ustalona i stanowi wówczas parametr obliczeń 

orientacji wzajemnej, a nie niewiadomą.  

Po ustaleniu wartości Bx pozostaje osiem stopni swobody w sumie dla obu wiązek. Do rozwiązania 

zagadnienia wystarczy pięć stopni swobody. Z tego względu istnieje możliwość uzyskania tego samego 

efektu (przecięcia promieni) różnymi drogami: metodą dostrajania obu zdjęć do siebie (metoda kątowa) 

oraz metodą dostrajania zdjęcia prawego do nieruchomego lewego (metoda kątowo-liniowa). W 

pierwszej metodzie wykorzystujemy jako stopnie swobody tylko elementy kątowe obu wiązek (np. fi, 

kappa – lewego i omega, fi, kappa – prawego). W drugiej metodzie kątowo–liniowej lewe zdjęcie 

przyjmuje się jako ściśle pionowe (omega, fi, kappa przyjmuje się zero), a wykorzystywane są wszystkie 

dostępne stopnie swobody prawego zdjęcia -trzy elementy kątowe oraz składowe bazy BY i BZ.  

W systemie DEPHOS zaimplementowano metodę kątowo-liniową.  

Wielkość BX przyjmowana jest przez program jako składowa bazy w skali zdjęcia (bx) . Nie jest to wielkość 

podawana przez operatora, lecz obliczana przez program, jako średnia paralaksa podłużna ze 

współrzędnych x’ i x’’ wszystkich punktów użytych do obliczeń. W takim przypadku model, przez który 

rozumiemy punkty przecięcia promieni jednoimiennych powstaje w skali bardzo zbliżonej do wymiarów 

matrycy kamery cyfrowej.   

Obliczenie 5 elementów orientacji wzajemnej oraz współrzędnych przecięcia promieni jednoimiennych 

wykonuje się w przestrzennym układzie modelu, który pokrywa się z przestrzennym układem tłowym 

zdjęcia lewego (w metodzie kątowo-liniowej z założenia elementy kątowe lewego zdjęcia są równe zero). 

Układ ten zaczepiony jest w środku rzutów lewego zdjęcia, osie X i Y są odpowiednio równoległe do osi x 

i y na zdjęciu, a oś Z pokrywa się z osią kamery. 
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Ze względu na nieliniowość równań kolinearności, z których wyznaczane są elementy orientacji 

wzajemnej, proces obliczeniowy przeprowadzany jest iteracyjnie, natomiast jako przybliżone wartości 

elementów orientacji wzajemnej przyjmuje się wartości zerowe.  

Miarą poprawności przeprowadzonej orientacji wzajemnej jest szczątkowy błąd nieprzecięcia promieni 

jednoimiennych. Ponieważ wektor nieprzecięcia promieni (definiowany jako odcinek najkrótszej 

odległości pomiędzy promieniami skośnymi) występuje w kierunku prostopadłym do bazy (kierunek 

zbliżony do kierunku osi Y), dlatego nazywa się go błędem szczątkowym paralaksy poprzecznej. 

Przyjmujemy, że dla dobrze wykonanej orientacji wzajemnej wielkość tego błędu w skali zdjęcia nie 

powinna przekraczać 0.5 piksela. 

W wyniku orientacji wzajemnej uzyskujemy tak zwany model fotogrametryczny. Nie posiada on jeszcze 

właściwej orientacji bezwzględnej, ale pozwala na prowadzenie pomiaru stereoskopowego w skali 

modelu. Układ modelu w przypadku kątowo-liniowej metody orientacji jest tożsamy z przestrzennym 

układem tłowym zdjęcia lewego. Mierzone na zdjęciach punkty homologiczne uzyskują współrzędne w 

tym właśnie układzie. 

W celu realizacji orientacji wzajemnej należy pomierzyć, co najmniej 5 par punktów, reprezentujących 

promienie homologiczne (czyli jednoimienne tzn. takie, które reprezentują obraz tego samego punktu w 

obu wiązkach). Punkty te mierzymy w tzw. sześciu rejonach Grubera. Takie rozmieszczenie punktów 

zapewnia korzystne geometrycznie uwarunkowania rozwiązania a ponadto dysponujemy jedną 

obserwacją nadliczbową, co umożliwia ocenę dokładności wykonanych pomiarów i wykrycie błędów. 

Błędy mogą być spowodowane np. pomyłką w identyfikacji punktów. Uściślając, mierząc sześć lub więcej 

punktów wiążących, dążymy do jak najlepszego przecięcia się promieni jednoimiennych, czyli takiego, dla 

którego promienie jednoimienne będą przechodzić jak najbliżej siebie. 

 

Ad. 4. Orientacja bezwzględna 

Orientacja bezwzględna jest procedurą, w której wyznaczane są współczynniki 7-parametrowej 

transformacji przestrzennej układu modelu do układu terenowego (geodezyjnego). Do wykonania tego 

zadania konieczne jest posiadanie na stereogramie, co najmniej trzech fotopunktów, nieleżących na 

jednej prostej. Współrzędne terenowe tych fotopunktów uzyskujemy np. w wyniku pomiaru 

geodezyjnego. Współrzędne fotopunktów w układzie modelu uzyskujemy w drodze ich pomiaru na 

zdjęciach po orientacji wzajemnej. Jak w każdym z poprzednich etapów należy dążyć do tego, aby 

posiadać spostrzeżenia nadliczbowe umożliwiające wykonanie analizy dokładności przeprowadzonego 

etapu. W ramach wykonanej transformacji obliczane są elementy orientacji bezwzględnej modelu. 

Umożliwia to określenie elementów orientacji zewnętrznej zdjęć, co pozwala na generowanie dalszych 

produktów kartograficznych. W skrócie można powiedzieć, że 12 elementów orientacji zewnętrznej 

uzyskujemy w drodze wyznaczenia 5 elementów orientacji wzajemnej oraz 7 elementów orientacji 

bezwzględnej (5+7=12). 
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W systemie DEPHOS obliczenie orientacji wzajemnej oraz bezwzględnej wykonuje się w programie 

DEPHOS External Orientation. 

 

 

3. ZAPOZNANIE SIĘ Z PROJEKTEM FOTOGRAMETRYCZNYM W PROGRAMIE DEPHOS MANAGER 

 

Skrótem DEPHOS41103virtual.exe, z menu rozwijalnego Start należy uruchomić program DEPHOS 

Manager. 

 

W menu głównym programu należy wybrać File->Open i wskazać plik projekt.fpr we własnym katalogu. 

 

Zapisać projekt pod własnym nazwiskiem: File->Save As... (Nazwa pliku: Nazwisko_studenta) 

 

W systemie DEPHOS na projekt fotogrametryczny składa się zestaw plików, które posiadają taką samą 

nazwę, a różnią się rozszerzeniami. Treść plików jest możliwa do zobaczenia w odpowiednich zakładkach 

programu DEPHOS Manager. 

Program DEPHOS Manager posiada 5 zakładek, które odpowiadają poszczególnym plikom projektu 

fotogrametrycznego: 

 

 

 

Plik projektu 

fotogrametrycznego 

Zakładka programu 

DEPHOS Manager 
Opis zawarto ści 

*.fpr (file project) PROJECT ogólne informacje na temat bloku 

*.fcm (file-camera) CAMERA dane kamer 

*.fpt (file photo) PHOTO dane zdjęć 

*.fmd (file model) MODEL dane modeli 

*.fct (file control) CONTROLS dane fotopunktów 

*.fmt (file measure tie points) Uzupełniane w 

programie DEPHOS 

ExternalOrientation 

pomiary na zdjęciach punktów 

wiążących 

*.fmc (file measure control points Uzupełniane w 

programie DEPHOS 

ExternalOrientation 

pomiary na zdjęciach fotopunktów 
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Klikając w klawisze: 
 

  
otwiera się odpowiednie zakładki. Należy zwrócić uwagę na: 

a) dane ogólne w zakładce Project dotyczące naszego projektu: ilość kamer, zdjęć, modeli i 

fotopunktów, podana przybliżona wysokość lotu oraz średnia wysokość terenu, 

b) dane dotyczące kamery w zakładce Camera: brak parametrów dystorsji, elementy orientacji 

wewnętrznej, rozmiar piksela itd, 

c) dane zdjęć w zakładce Photo: rozróżnienie nazwy zdjęcia w projekcie (Name) od nazwy pliku na 

dysku (Image File), przyporządkowanie do szeregu, przyporządkowanie kamery, brak wartości 

macierzy orientacji wewnętrznej IO Ax ... IO Dy (przed obliczeniem orientacji wewnętrznej) oraz 

brak elementów orientacji zewnętrznej EO X ... EO Kappa.  

d) dane modelu w zakładce Model: wskazanie zdjęcia lewego i prawego, brak elementów orientacji 

bezwzględnej Left AO X ... Right AO Kappa. 

e) dane fotopunktów w zakładce Controls: numery, współrzędne i błędy wyznaczenia współrzędnych. 

 

 

 

 

 

 

 

4. OBLICZENIE ORIENTACJI WEWNĘTRZNEJ (Uwaga w czasie pracy na sali 508 należy często zapisywać 

projekt (menu File/save) lub wyniki pomiaru) 

 

W zakładce Camera należy wpisać parametry z metryki kamery: 

 

Serial Number  00120742   

Number of rows/columns 
[pixels]  

15552 x 14144   

Pixel Size [µm]  5.600 x 5.600   

Image Size [mm]  87.0912 x 79.2064   

Focal Length [mm]  92.0071 mm  + /- 0.002 mm  
Principal Point [mm]  X= 0.000 mm,  

Y= 0.000 mm  
+ /- 0.002 mm  

 

UWAGA: Wszystkie wartości do programu wpisujemy w mm. Do uzupełnienia są wiersze Focal Length, 

Pixel Size, Film Format X, Film Format Y, PPAC X, PPAC Y.  PPAC X, PPAC Y to współrzędne punktu 

głównego  (Principal Point) 
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Obliczenie orientacji wewnętrznej dla zdjęć cyfrowych przeprowadza się w programie DEPHOS Manager. 

W zakładce Photo należy zaznaczyć oba zdjęcia, a następnie z menu głównego Photos -Calculate IO for 

digital cameras, wybrać opcję Use Pixel Size and Film Format. Po obliczeniu powinny pojawić się 

parametry macierzy orientacji wewnętrznej w polach IO tabeli danych w zakładce Photos. 

 

Należy zwrócić uwagę, czy wartości IO pojawią się dla obu zdjęć. Sprawdzenia dokonujemy klikając 

kolejno na oba zdjęcia.  

Warto zwrócić uwagę na wyznaczone wartości parametrów IO. Przykładowo, IO Ax to połowa formatu w 

mm w kierunku x ze znakiem minus. Natomiast IO Bx to rozmiar piksela (PixelSize), a IO Ay to połowa 

formatu w kierunku y. 

Macierz orientacji wewnętrznej przelicza współrzędne pikselowe na współrzędne tłowe: 

 

Ostatecznie zapisujemy zmiany w projekcie i opuszczamy program DEPHOS Manager. 

 

5. POMIAR PUNKTÓW WIĄŻĄCYCH I OBLICZENIE ELEMENTÓW ORIENTACJI WZAJEMNEJ 

Otwieramy program DEPHOS Exterial Orientation. 

Wybieramy własny projekt w oknie Open project. 

Następnie wyświetlamy zdjęcia klawiszem Open photos. 
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w oknie Select photos zaznaczamy First strip, wybrać szereg 1 oraz zdjęcie początkowe First photo w 

naszym modelu. Aby zdjęcia wyświetliły się prawidłowo, należy ustawić parametry wyświetlania bloku, 

jak poniżej : 

 

 
 

W przypadku komunikatu o braku obrazów, należy w programie DEPHOS Manager (zakładka Photo) 

sprawdzić, czy ścieżki do obrazów są prawidłowe i czy obrazy istnieją we wskazanym. Jeśli ścieżka 

dostępu (pole Details tabeli Photo - pozycja Image file) wskazuje błędną lokalizację, należy ją zmienić dla 

obu zdjęć osobno. Jeśli nie ma obrazów pod wskazanym adresem - należy je skopiować z serwera do 

D:\Tify\OrientacjaDEPHOS_2014\. 

 

Rozmiar okien wyświetlających całe zdjęcia reguluje się poprzez zmianę wielkości danego okna, a 

następnie zapis ustawień pozycją menu głównego - Options -> Windows size -> Photo. 

 

Przełączanie się pomiędzy oknami Photo i Zoom wykonuje się skrótami klawiszowymi: 

Show zoom window Alt+W – pokaż okno z powiększeniem, 

Show photos Alt+D – pokaż okna zdjęć 

lub wybierając opcję w menu kontekstowym (przy położeniu kursora nad oknami zdjęć lub powiększeń) 

Inne przydatne opcje menu kontekstowego oraz służące do pomiaru i jego kontroli są następujące: 

 

Set point  Alt+E – pomiar punktu, 

Zoom In Alt+Z – powiększ zdjęcie, 

Zoom Out Alt+X – pomniejsz zdjęcie, 

Next point & display Shift+Q – przejdź do następnego punktu i pokaż wszystkie 

zdjęcia, na których występuje. 

 

Pomiar punktów wiążących Tie points odbywa się poprzez wybór klawisza Add tie point: 
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Tryb pomiaru Set point włącza się prawym klawiszem w menu kontekstowym. Następnie wskazuje się 

punkt wiążący w jednym z rejonów Grubera na obu zdjęciach (okna Photo). Punkty wiążące są punktami 

dostosowania dla orientacji wzajemnej... 

 

Należy pomierzyć po dwa punkty w każdym z rejonów Grubera. Dla porządku proponowana kolejność 

pomiaru jest następująca: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Po wskazaniu punktów w przybliżonych obszarach na zdjęciach, należy poprawić ich położenie 

wykorzystując powiększenia zdjęć (okna Zoom). Otwieramy dialog Points klawiszem Show dialog, który 

zawiera dane pomiarowe i narzędzia obliczeniowe, wskazujemy jego zakładkę Tie Points zawierającą 

tabelę pomiarów naszych punktów wiążących. 

 

 

 1 1 

2 

3 
4 

5 
6 

7 
8 

9 

 10 
 

11 

12 
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Każdy punkt posiada podane: nazwę zdjęcia, na którym został pomierzony, oraz współrzędne w 

pikselach. 

Teraz trzeba doprecyzować nasze wstępne pomiary. W dialogu Points dwukrotnie klikamy poniżej 

numeru pierwszego punktu wiążącego, w puste pole obok numeru zdjęcia i kombinacją klawiszy Alt+W 

wyświetlamy powiększenie zdjęcia w obszarze danego punktu. Zmiana obszaru okien powiększeń Zoom 

możliwa jest analogicznie, jak w przypadku zmiany wielkości okien zdjęć Photo (z menu głównego 

Options - Windows size - Zoom). Przy ustawianiu wielkości okien Zoom zaleca się stosowanie okien 

zbliżonych kształtem i wielkością do okien Photo. 

 

Trzeba przejść do trybu pomiaru (Alt+E lub prawy klawisz opcja: Set point), regulując dogodne 

powiększenie (Alt+Z/Alt+X), wstawiamy punkt  precyzyjnie na obu zdjęciach, na których został zgrubnie 

pomierzony. Następnie z menu kontekstowego wybieramy pozycję Next point & display (Shift+Q) i 

wyświetlamy kolejny punkt, którego położenie poprawimy. Znaczne przyspieszenie pracy uzyskuje się 

używając skrótów klawiszowych dla poleceń menu kontekstowego. 

 

Po pomiarze punktów wiążących wykonuje się obliczenia. W zakładce Parameters dialogu Points należy 

zaznaczyć opcję Relative only oraz wpisać maksymalną, dopuszczalną wartość paralaksy szczątkowej  dR 

jako połowę wielkości piksela obrazowego PixelSize, czyli w naszym przypadku 0.003mm. Po naciśnięciu 

ikony Calculate w zakładce Tie points dialogu Points zostaną wyświetlone szczątkowe paralaksy. 

Należy ustawić w polu Max. Values wartość dR 0.003 mm jako graniczną dopuszczalną (połowa wielkości 

piksela, która wynosi 0.0056 mm) oraz przewidywaną dokładność pomiaru Measurement accuracy 

również 0.003 mm. 
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Kontrola jakości orientacji wzajemnej, wynikającej z dokładności pomiaru punktów wiążących, odbywa 

się poprzez sprawdzenie ich wartości dR - poprzecznych paralaks szczątkowych uzyskanych na punktach. 

Nie powinny one przekraczać połowy wielkości piksela (Pixel Size), czyli 0.003mm. Sortowanie tabeli 

według wartości w kolumnie dR odbywa sie przez dwukrotne kliknięcie w nagłówek tej kolumny. W razie 

konieczności położenie danego punktu na zdjęciu można poprawić. Istnieje możliwość skasowania 

punktu lub danego pomiaru (Remove w menu kontekstowym w polu tabeli) lub tymczasowego 

wyłączenia (Freeze) danego pomiaru (jeden wiersz tabeli) lub wszystkich pomiarów dla danego punktu. 

Kasowanie lub wyłączenie danego pomiaru odbywa się przez wybór opcji z menu kontekstowego z 

kursorem umieszczonym na numerze zdjęcia, natomiast kasowanie lub wyłączenie całego punktu 

odbywa się przez wybór opcji z menu kontekstowego z kursorem umieszczonym na numerze punktu. 
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Menu w polu dialogu Points 

 

Remove – usuń punkt (na stałe) z obliczeń 

Freeze – wyłącz (tymczasowo) punkt z obliczeń  

Show Photos – pokaż wskazany punkt na zdjęciu 

Select From Map – pokaż wskazany punkt na rysunku poglądowym 3D 

Next Point on photos – przejdź do następnego punktu na aktywnym zdjęciu 

Next Point – przejdź do następnego punktu 

Next Point & display  – przejdź do następnego punktu i wyświetl 

Rename – zmień nazwę 

 

Po skontrolowaniu (i ewentualnej poprawie pomiaru i ponownym przeliczeniu) wartości szczątkowej 

paralaksy poprzecznej należy zapisać wyniki ikoną Save: 

 

W celu zobaczenia wyników orientacji wzajemnej, czyli 

obliczonych elementów orientacji wzajemnej należy uruchomić program DEPHOS Manager, otworzyć 

projekt (File->Open), a następnie klawiszem Model otworzyć zakładkę z danymi modeli. Obliczone 

elementy orientacji wzajemnej są tymczasowo wstawione do pól Left AO X ... Right AO Kappa. Zgodnie z 

konwencją, lewe zdjęcie posiada (tymczasowo, zanim nie obliczy się orientacji bezwzględnej) zerowe 

elementy orientacji bezwzględnej Left AO X ... Left AO Kappa (jedynie Left AO Z = 1000), natomiast 

wartości elementów orientacji bezwzględnej zdjęcia prawego (Right AO X ... Right AO Kappa) są 

faktycznie wartościami elementów orientacji wzajemnej tego modelu. Po późniejszym obliczeniu 

orientacji bezwzględnej w odpowiednie miejsca zostaną już wstawione elementy orientacji zewnętrznej 

obu zdjęć, a elementu orientacji wzajemnej nie będą miały znaczenia i zostaną nadpisane elementami 

orientacji bezwzględnej, które są konieczne do prawidłowego wyświetlenia modelu stereoskopowego we 

współrzędnych przyjętego układu terenowego. 
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6. POMIAR FOTOPUNKTÓW  

Wracamy do programu DEPHOS External Orientation. 
Otwieramy nasz projekt w oknie Open Project. 
Wyświetlamy nasz model : 

... 
i otwieramy dialog Points: 

 
Orientacja bezwzględna jest transformacją układu modelu do układu terenowego. Punktami 
dostosowania są fotopunkty, które mierzone są na zdjęciach, a znane są ich współrzędne terenowe. 
Należy pomierzyć te fotopunkty, które wynikają z podziału danych przez prowadzącego zajęcia. Każdy 
student mierzy 5 fotopunktów. Ich współrzędne terenowe są zapisane w projekcie i można je zobaczyć w 
zakładce Controls programu DEPHOS Manager. Ich rozmieszczenie na zdjęciach przedstawione jest 
poniżej (w pliku osnowa.jpg po powiększeniu obrazu można zobaczyć dokładną lokalizację fotopunktów). 
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Fotopunkty mierzymy ikoną Add Control Points 
 

 i zaznaczamy punkt na liście według rozdziału danych do ćwiczenia. 
 
Następnie w oparciu o powyższy fotoszkic mierzymy go zgrubnie w oknach zdjęć na zdjęciach (włączamy 
tryb Set point kombinacją klawiszy Alt+E lub z menu kontekstowego), jak w przypadku punktów 
wiążących. 
 

 
 
Poprawiamy pomiar na powiększeniach zdjęć (Alt+W). Należy wstępnie sprawdzić poprawność pomiaru 
jeszcze raz licząc orientację wzajemną po pomiarze punktów kontrolnych (przy zaznaczonym Relative 
only w zakładce Parameters dialogu Points nacisnąć klawisz Calculate) i sprawdzając zawartość kolumny 
dR w zakładkach Control points oraz Tie points. Sortowanie według wartości dR odbywa się poprzez 
dwukrotne kliknięcie na nagłówek tej kolumny w tabeli.  
Mogło się zdarzyć podczas pomiaru fotopunktów, że został popełniony błąd i pojawiła się szczątkowa 
paralaksa poprzeczna na którymś z fotopunktów lub punktów wiążących, przekraczająca dopuszczalne 
pół piksela. 

 



Akademia Górniczo-Hutnicza w Krakowie - WGGiIŚ 
opracowali: A. Boroń, A. Rzonca, A. Wróbel 

 

18 

 

 
7. OBLICZENIE ELEMENTÓW ORIENTACJI BEZWZGLĘDNEJ I ELEMENTÓW ORIENTACJI ZEWNĘTRZNEJ 
ZDJĘĆ 
 
W zakładce Parameters dialogu Points odznaczamy Relative only i otwieramy zakładkę Report dialogu 
Points. Naciskamy klawisz Calculate i czekamy. 
 

 
 
Kontrola jakości orientacji bezwzględnej - dokładności pomiaru fotopunktów w terenie i na zdjęciach - 
odbywa się poprzez sprawdzenie wartości odchyłek VX, VY, VZ podanych w zakładce Control Points 
dialogu Points. Przyjmuje się, że średni błąd pomiaru fotopunktów wynosi od 0.5 piksela do jednego 
piksela. W związku z tym przyjmujemy, że wartości odchyłek VX, VY, VZ  nie powinny przekraczać 
wartości 0.20 m. Sortowanie tabeli według wartości w kolumnach VX, VY, VZ odbywa sie przez 
dwukrotne kliknięcie w nagłówek tej kolumny. dB - różnica pomiędzy położeniem wiązki przed i po 
wyrównaniu. W razie konieczności położenie danego punktu na zdjęciu można poprawić. Istnieje 
możliwość: 

• skasowania punktu (prawe kliknięcie na numerze punktu, polecenie Remove) 

• tymczasowego wyłączenia punktu (prawe kliknięcie na numerze punktu, polecenie Freeze). 
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Po stwierdzeniu poprawności obliczeń zapisujemy zmiany w projekcie: 

i możemy wyjść z programu DEPHOS External Orientation. 
 
Wyniki w postaci obliczonych elementów orientacji zewnętrznej można zobaczyć w zakładce Model 
programu DEPHOS Manager, po uprzednim otwarciu naszego projektu. 
 

 
Projekt jest gotowy do pomiaru autogrametrycznego - do wykorzystania w programie DEPHOS Mapper 
Stereo. 


